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© 2022 Terrasolid Ltd

All rights reserved. No parts of this work may be reproduced in any form or by any means -
graphic, electronic, or mechanical, including photocopying, recording, taping, or information
storage and retrieval systems - without the written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered
trademarks of the respective owners. The publisher and the author make no claim to these
trademarks.

While every precaution has been taken in the preparation of this document, the publisher and
the author assume no responsibility for errors or omissions, or for damages resulting from the
use of information contained in this document or from the use of programs and source code
that may accompany it. In no event shall the publisher and the author be liable for any loss of
profit or any other commercial damage caused or alleged to have been caused directly or
indirectly by this document.

Printed: September 2022 in Finland.

Trademarks

TerraBore, TerraGas, TerraHeat, TerraLink, TerraMatch, TerraModeler, TerraOpen, TerraPark,
TerraPhoto, TerraPipe, TerraScan, TerraSlave, TerraStereo, TerraStreet, and TerraSurvey are
trademarks of Terrasolid Limited.

Spatix is a trademark of GISware Integro.

MicroStation®, MDL® and MicroStation stylized "M" are registered trademarks of Bentley
Systems, Incorporated. Bentley Map PowerView and MicroStation CONNECT are trademarks of
Bentley Systems, Incorporated.

Windows is a trademark of Microsoft Corporation.

Acrobat Reader is a trademark of Adobe Systems Incorporated.

OSTN02 and OSTN15 are trademarks of Ordnance Survey, the national mapping agency of Great
Britain.

Intergraph Raster File Formats - Copyright - 1994 Intergraph Corporation. Used with permission.
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About this User Guide

This document serves as a user's guide for the Terra License Server/Manager. Terra License
Server/Manager are Windows applications.

The PDF version of the user guide is created in order to provide an offline version of the online
webhelp. It shall be updated together with the webhelp. Some parts of the webhelp may be
left out on purpose in the PDF document. In case of inconsistency, the online webhelp is the
primary source of information. The user is responsible for keeping his/her offline version
updated.

Document conventions

The following conventions and symbols appear in this guide:

· OR - alternate procedures or steps in a procedure.

· C:\TERRA64 - paths to directories of files on a hard disk are written with capital letters.

· To do  - the beginning of a workflow is introduced with bold-italic letters.

Notes and hints are highlighted in light blue boxes.
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Introduction

Terra License Server and Terra License Manager provide the capability for the customer to
maintain a pool of network licenses. Individual workstations (clients) can request licenses from
the pool according to the processing needs. This gives flexibility in using licensed Terrasolid
applications, such as TerraScan, TerraMatch, TerraPhoto, TerraModeler, etc. on different
computers.

The network license system provides the following benefits:

· You can freely decide which computers run licensed Terra applications.

· You can easily move licenses from one client computer to another.

· When you start a long batch process, you only need to leave the license for that application
on the client computer. You can return other licenses to the server and move those to
another client.

· You can request a license to be used on a notebook computer for a given number of days.
The notebook needs to be connected to the network only at the time of requesting the
license. If the notebook never returns to the main office, the requested license becomes
available again when the validity period ends.

Terra License Server runs on a machine acting as a server. Any Windows computer can act as a
license server. The server computer stores a collection of network licenses. Clients can request
a specific application license for a given number of days. The license server will grant the
license if one is available for that application. The client can return the license to the server at
any time. If not returned by the client, the license will automatically become available in the
pool once the validity period ends.

Terra License Service is a service version of the license server. It runs in the background without
a user interface. When Terra License Service is installed, Terra License Server will act merely as
a user interface for viewing the status of the license pool being managed by the service and for
changing settings. The use of the service is highly recommended because it makes the licenses
requests/returns by clients independent of the License Server application running.

Terra License Manager is installed on the client computers where customers want to use the
licensed Terrasolid applications. Terra License Manager communicates with Terra License
Server through a Windows network whenever requesting or returning a license.

A computer can also act as the license server and be a client at the same time.

The alternative to network licenses are so-called node-locked licenses. They are fixed to the
name and ID of one computer and can not be moved to other computers. Node-locked
licenses do not need any license management software. More information about Terrasolid
license models are provided on the webpage.

https://terrasolid.com/licenses/
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Hardware and software requirements

Terra License Server and Terra License Manager are Windows-based applications. For running
the x64 version of the application, a 64-bit Windows OS is required. Any Windows PC can act as
a license server for Terrasolid licenses.

The individual workstation computers must be on the same network with the computer acting
as the server and able to communicate with the server computer in that network.

Installation

You should carefully consider to which computer to install the Terra License Server. The
network licenses that you get from Terrasolid will only work on that specific computer. You
should therefore install Terra License Server on a computer which you plan to use for a long
time.

After the installation, you must configure the Terra License Server/Manager.

To install Terra License Server or Terra License Manager:

1. Start setup.exe in the installation package with administrator permissions.

This opens the Terra Setup dialog:

2. Define the installation folder(s) where to install Terra License Server/Manager. The same
installation folder must be used for all Terrasolid applications.

The default Folder choice is Default c:\terra64. This installs all executables and setting files
into the same folder C:\TERRA64. The folder is created automatically, if it does not exist.
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As an alternative, if executables and settings files need to be separated, select another
Folder choice:

· Default 'Program files' - executables are installed into C:\PROGRAM FILES\TERRASOLID,
setting files are installed into C:\TERRA64.

· Freely selectable folders - the user defines a folder for Executables and Settings in the
corresponding input fields. Click on the Browse button next to each input field in order to
select a folder.

3. Select Terra License Manager, Terra License Server and/or Terra License Service to install.

Terra License Server and optionally the Service must be installed on the computer that acts
as license server for Terrasolid licenses. The installation of the Service is optional but highly
recommended.

Terra License Manager must be installed on any computer on which you want to run the
licensed Terrasolid applications, such as TerraScan, TerraMatch, TerraPhoto, TerraModeler,
etc..

One computer can act as license server and run the Terrasolid applications at the same time.

4. Click OK.

When the installation is finished, a message is displayed.

The Terra License Server and Service executables are located in the folder defined above for
executables, e.g. by default in C:\TERRA64\POOL0XX where XX stands for the current version
number.

The Terra License Manager executable is located in the folder defined above for
executables, e.g. by default in C:\TERRA64\LICENSE.

Server information must be sent to Terrasolid when a new computer is taken into use as
license server for Terrasolid applications. This may be the case if you become a new
customer of Terrasolid or if you need to move your licenses from one to another server
computer. Please note that Terrasolid does not accept frequent moves of licenses.

Starting Terra License Server

The Terra License Server application is located in the installation folder that is defined in the
setup process. By default, the folder is C:/TERRA64/POOL0XX where XX stands for the current
version number. Start the application with a double-click on the license_server.exe.

Terra License Service

The Terra License Service is a Windows service with the name TerraLicenseService0XX where XX
stands for the current version number. It is started automatically after installation and also
when the PC is restarted. You can manually start/stop/restart the service in the Windows
Services window.
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Restarting the service is always required after new network licenses files have been copied
into the /POOL0XX folder, or after settings have been changed.

Starting Terra License Manager

The Terra License Manager application is located in the installation folder that is defined in the
setup process. By default, the folder is C:/TERRA64/LICENSE. Start the application with a
double-click on the license_manager.exe.
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Configure License Server/Manager

To configure Terra License Server,  you must perform the following steps:

1. Enter settings in the License Server application.

2. Enter settings in the License Manager application.

3. Test that License Server and License Manager can communicate with each other over the
network.

4. Send server information to Terrasolid in order to request licenses for Terrasolid applications.

Terrasolid will process your request and send the license files by email to the contact person
of your company. The license files are only working on the specific computer from which
they have been requested.

5. Copy the network license files to the installation folder of the Terra License Server, such as
C:/TERRA64/POOL0XX where XX stands for the current version number.

Enter License Server Settings

The License Server settings specify an access code for the server/manager communication, the
maximum duration for which licenses can be checked out on client computers and a time
interval for closing and reopening the communication pipe.

To enter server settings:

1. Start Terra License Server application.

2. Select Settings command from File pulldown menu.

This opens the Settings dialog:

3. Specify an Access code. All client computers must use exactly the same access code.

4. Enter the Maximum duration for which licenses can be checked out. A short duration requires
users to renew licenses more frequently, but it is safer -- if a computer with borrowed
licenses breaks down, the licenses will become available as soon as the validity period ends.

5. Define a Reopen pipe value. The value determines the time interval for closing and
reopening the communication pipe between server and client computers.
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6. Click OK.

This saves the settings into a configuration file named LICENSE_SERVER.UPF and stored in the
same folder as the License Server application.

Licenses are returned to the server automatically after the check-out period ends or
manually by the License Manager on the client computer. If a client computer breaks down
or if the licenses can not be returned for another reason from the client computer, the
licenses are blocked until the check-out period ends. There is no way of forcing the return of
licenses in the server application. Therefore, it is strongly recommended to limit the
maximum duration for the license check-out to a reasonable amout of days.

Enter License Manager Settings

The License Manager settings specify an access code for the server/manager communication
and the name of the computer acting as License Server for Terrasolid applications.

To enter manager settings:

1. Start Terra License Manager application.

2. Select Settings command from File pulldown menu.

This opens the Settings dialog:

3. Enter the name of the computer acting as License Server. You can click on >> button to browse
for computers in the network.

4. Specify the Access code. The code must match excactly the access code defined in the License
Server settings.

5. Click OK.

This saves the settings into a configuration file named LICENSE_MANAGER.UPF and stored in
the same folder as the License Manager application.
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Test License Server/Manager communication

To test the communication over a network, you need to have Terra License Server installed on
one computer and Terra License Manager on another computer. Settings must have been
defined in the License Server and License Manager applications.

To test Server/Manager communication:

1. Start Terra License Server application on the one computer.

Check the Event log in the lower left part of the application window for the version number
(018, 019, ...) that it is going to serve:

2. Start Terra License Manager application on another computer.

3. Select Server state command from the View pulldown menu.

This opens the Server state dialog:

4. Select the Version number of the licenses that are served in the License Server.

The dialog shows the number of free out of the number of available licenses on the server
machine or another message.

‘No pool licenses’ message indicates that the communication is successful but there are no
network license files in the /POOL0XX folder on the server computer.

‘No reply from server’ message indicates that the License Manager cannot establish
communication with the server. Check the network connection between the computers, e.g.
in the Windows Explorer. The client computer must see the server computer in the Network
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section of the Windows Explorer. In addition, double-check all the installation and setup
steps to make sure everything is done properly.

'Bad access code' message indicates that the access code values in the License Manager
Settings and the License Server Settings do not match. It can also mean that the License
Service has not been restarted after new license files have been added on the server
machine, or after settings have been changed.

Send License Server information

You must send the server computer name and identification number to Terrasolid in order to
request network licenses. The network licenses that you receive from Terrasolid will only work
on that specific computer.

To send server computer details:

1. Start Terra License Server application.

2. Select Server information command from File pulldown menu.

This opens the Server information dialog:

Click the Open web button in order to open a web form. In the form, you can fill all other
necesary details for requesting licenses. This is the preferred procedure.

Alternatively, click the Copy button to copy the name and ID of the computer to the clip board.
You can then paste the values into an E-mail that you send to Terrasolid. In the email, you must
provide information about your company and why you are requesting licenses (new server
computer, new license file request, etc.). Please note that the web form helps you to provide
all necessary information and thus, the request may be handled faster.

If you are eligible for licenses, you or the contact person of your company provided in the web
form will receive an email containing your license files. Copy the files to the installation folder
of the Terra License Server, such as C:/TERRA64/POOL0XX where XX stands for the current
version number. Restart the License Service after adding new license files to the license server.

Server information must be sent to Terrasolid when a new computer is taken into use as
license server for Terrasolid applications. This may be the case if you become a new
customer of Terrasolid or if you need to move your licenses from one to another server
computer. Please note that Terrasolid does not accept frequent moves of licenses.
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Run Terra License Server

Terra License Server needs to be running whenever client computers want to request or return
licenses.

A better alternative is to install Terra License Service together with the License Server. The
service runs as Windows service which is started automatically after installation and when the
computer is rebooted. In this case, the Terra License Server application acts as user interface for
viewing the status of the network licenses or for changing server settings.

The application window shows the current state of the network licenses and logs every license
request and return event.

Licensed applications list shows a list of applications for which there are valid license files in
the License Server installation folder, usually C:/TERRA64/POOL0XX where XX stands for the
current version number.

Licenses list shows the status of each license for the application selected in Licensed
applications list. This includes the license number, the name of the client computer that uses
the license and the return date for the license.

Event log shows all the events since the program was last started. This includes information
about licenses, for example issues arising from bad licenses (invalid license files, different
major version licenses in the same folder, etc.). The events are also written into a text file
named LICENSE_SERVER_LOG.TXT which is stored in the License Server installation folder,
usually C:/TERRA64/POOL0XX where XX stands for the current version number. The text file
contains all events since the License Server installation.

The Terra License Server Settings can be opened from the File pulldown menu.
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Run Terra License Manager

Terra License Manager needs to be running whenever the user on a client computer wants to
request or return a license..

The application window shows the list of all Terrasolid applications and any licenses that are
currently used on this computer. For each license, the version number, license type and return
date are displayed.

COMMAND EFFECT

File / Settings Open Terra License Manger Settings.

License / Get from server Request a license from the License Server.

License / Return to server Return a license to the License Server

View / Hide selected applications Hide applications from the list in the
application window

View / Show all applications Show all applications in the list in the
application window

View / Server state Check the state of the License Server and the
communication between License Manager
and License Server
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Request a licenses

The most common task with Terra License Manager is to request new licenses from the server.
This is required in order to run a licensed Terrasolid application on the client computer.

To request licenses:

1. Select all applications in the Terra License Manager window for which you want to request a
license.

2. Select Get from server command from License pulldown menu.

This opens the Get from Server dialog:

3. Select the Version of the application.

4. Enter the last date in the Valid thru fields on which the license should be usable on the
computer. At the end of this day, the license is returned to the server and becomes available
for check-out again. The format of the date is DD/MM/YYYY (day/month/year). The Duration
field is updated accordingly and shows the amount of days the license is valid on this
computer.

OR

4. Enter the amount of days in the Duration field for which the license should be usable on hte
computer. The Valid thru fields are updated accordingly and show the last day the license is
valid on this computer.

5. Click OK.

This sends a request to the server. If a license is granted, the version number, license type
and return date are displayed in the application window. Settings on the server may limit the
duration of the generated license.

The maximum duration for requesting a license is limited by the setting in the Terra License
Server application. If a longer validity period is choosen in the Get from server dialog, the
application sets it automatically to the maximum duration according the the server settings.



Terra License Server/Manager User Guide  © 2022 Terrasolid Ltd

17Run Terra License Manager > Request a license >  

Change the validity of a license

To change the validity of a license, request it again with a new duration. You can request for a
longer or a shorter duration. For example, if the computer is processing a long task with
TerraScan, you may request a longer license while TerraScan is busy.
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Return a license

You can return a license to the server at any time before it expires. This will make the license
available for another client computer.

To return licenses:

1. Select all applications in the Terra License Manager window for which you want to return the
license.

2. Select Return to server command from License pulldown menu.

This sends a return message to the server. A license disappears from the client computer if
the server confirms receiving the license.

There is no other way of returning a license than with the License Manager. Otherwise, a
license becomes only available again if the its validity ends on the client computer.
Therefore, it is recommended to request a license only for a reasonable short period of time.
This avoids that licenses are blocked by a client computer that runs into problems, breaks or
becomes otherwise unusable.
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Hide selected applications

By default, the Terra License Manager window displays all licensed Terrasolid applications.
Thus, the list may contain a lot of applications that you never use. It may be more convenient to
hide unused applications and show only those for which you have licenses.

To hide selected applications:

1. Select all applications in the Terra License Manager window that you want to hide.

2. Select Hide selected applications command from View pulldown menu.

This hides the selected applications from the list.

Show all applications

If you need to restore the visibility of all applications, select Show all applications command
from View pulldown menu.
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Installation Directories

Terra License Server/Manager share the same directory structure with all Terra Applications. It
is recommended that you install all Terra Applications in the same directory.

The list below shows a typical directory structure when Terra License Server/Manager have
been installed in path C:\TERRA64.

C:\TERRA64 directory where Terra License
Server/Manager were installed

 license for License Manager and temporary
license files

  license_manager.exe License Manager application

  license_manager.upf License Manager configuration file

 pool0XX for License Server and network license
files, XX = version number

  license_server.exe License Server application

  license_server.upf License Server configuration file

  license_server_log.txt License Server log file

  license_service0XX.exe License Service executable
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Further information

There are more sources of information about the Terra License Server/Manager installation and
setup beyond this User Guide. The following list summarizes the different options:

SOURCE SUITABLE FOR

Knowledgebase collection of FAQ
· troubleshooting the Terra License

Server/Manager setup

Release notes for Terra License
Server/Manager applications

· checking for new updates

Unfortunately, all other sources are no longer available.

Links last checked 13. September 2022

https://terrasolid.com/questions-and-answers/
https://terrasolid.com/release-notes/
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